
Mark’s Guide to Using Apple’s 
Ancient “Font Editor” App
In 1984, as owner of an original 128K Macintosh, I was 
very interested in how to make fonts for it. It came 
with a set fonts named after cities, like Geneva, New 
York, Monaco, and Athens. But there seemed to be no 
way for an ordinary user to make their own fonts. As a 
graphic designer and aspiring type designer, this was 
something I really wanted to do.

A solution arrived in the July 1984 issue of St. Mac, an 
early magazine devoted to the Macintosh. There was 
a short article on the last page saying that you could 
send $100 (plus tax) to Apple and get a set of disks 
containing “supplemental software” (i.e., developer 
tools) including an app called “Font Editor.” This was 
exactly what I was looking for. So I sent the check.

Font Editor, as far as I can remember, had no manual 
or documentation. By trial and error (and many system 
crashes), I managed to figure out how it worked. I was 
able to design a handful of bitmap fonts in preliminary 
stages. A few months later, Altsys released Fontastic, a 
commercial bitmap editor for the Mac that was better 
than Font Editor in almost every way—and that’s where I 
did most of my bitmap font work.

My vision was to sell sets of these fonts like clip art. 
But after Apple introduced the LaserWriter in 1985, 
and Altsys released Fontographer (an app for making 
PostScript fonts to use with it), I lost interest in making 
bitmap fonts.

Font Editor is very primitive and difficult to work with if 
you don’t know what you’re doing. It appears to only 
work on a 128K or 512K Macintosh (not the 512Ke). The 
only emulator I’ve gotten it to work with is a custom 
128K Macintosh variant of Mini vMac (See https://www.
gryphel.com/c/minivmac/). The original disk included 
Mac system software 1.0 (early 1984). It will also run 
on system software 2.0 (early 1985), but nothing later. 
This means that it can only be run from floppy disks 
(or floppy disk images in the case of vMac), since hard 
drives were not supported by these early systems.

This also means that it will only work with MFS disks (or 
disk images), not HFS disks. MFS disks have a flat file 
structure, meaning that all files on the disk are at the 
same level—no folder hierarchy. You can create folders 
in the Finder, but they are purely cosmetic and won’t 
appear in open or save dialog boxes. And you can’t 
have two files with the same name, even if they are in 
different “folders” because folders don’t really exist.

One of my early bitmap fonts, based on Century Expanded.

Bitmap fonts I made from 1984-86. I started 
out in Font Editor, but soon switched to 
Fontastic and Fontastic Plus.

Not even a custom icon.

The better tool.



System software 2.0 is preferable. System software 1.0 
is missing a lot of handy features, like “shut down” and 
“new folder.” In system 1.0, there had to be an “Empty 
Folder” on every disk. If you wanted a new folder, you 
were supposed to make a copy of “Empty Folder.” It’s 
hard to believe this was ever a thing, but it was for us 
early users in the first year of the Mac.

If you can meet all these requirements, you’re ready to 
use (or try to use) Font Editor.

First Steps
For this user guide, I’m going to be working in a 128K 
variant of Mini vMac on a modern MacBook Pro. I’ve set 
up an 800K MFS disk image containing the following 
files and apps:

• System Software 2.0 (from early 1985) with Finder 4.1
• Font Editor (from the Apple developer disk “5/85 

MacStuff 2”)
• Font/DA Mover 1.5 (from the disk “5/85 MacStuff 3”)
• Fonts (font suitcase containing a bunch of Apple 

bitmap fonts, from the disk “5/85 MacStuff 3”)
• ResEdit 0.5 (from the disk “5/85 MacStuff 1”)
• More Fonts (a folder containing some of the fonts I 

made c. 1984-85 using Font Editor) 

Note: 800K MFS disk images seem to be weirdly 
corruptible if used with later Macintosh models or 
operating systems in Mini vMac if you add files or 
folders to them. I’ve found the best workaround is to 
use a 400K MFS disk image to move files between 
emulated models and systems. I don’t know if this is 
true with real hardware, since the Macintosh Plus is the 
earliest model I currently own. 

On a real 128K, you’ll need to pare this setup down 
to fit on a 400K floppy, unless you have a compatible 
external 800K drive or a drive emulator, such as the 
Floppy Emu from BMOW. The easiest way to save space 
is by removing fonts from the System file and/or the 
Fonts suitcase file. I included most of Apple’s early fonts 
in my 800K set up because there was enough space. 

You don’t have to set it up exactly like this. The main 
requirements are System Software 2.0 with at least 
a few fonts like New York and Geneva installed, Font 
Editor, ResEdit 0.5, Font/DA Mover 1.5, and a Fonts 
suitcase containing at least one font, preferably not Los 
Angeles. And it must be an MFS floppy disk (for a real 
Macintosh) or MFS disk image (for Mini vMac).

My Font Editor disk image setup, as seen in Mini vMac.



Starting Up Font Editor
When you first start up Font Editor, you will be greeted 
by a dialog that says, “Enter the name of the font:” 
followed by a text field pre-populated with the name 
“System”, fields for “Current Size” and “NewSize”, and 
buttons for “OK” and “Cancel”.

Do not click “OK” or “Cancel” or you will get a system 
error (the dreaded “bomb” box) and you will have to 
restart.

It doesn’t matter what you enter here, as long as it’s not 
“System”. It also doesn’t matter what sizes you enter. We 
will see why shortly.

The app will beep twice and open two empty windows: 
“Font Editor 2.0” and “Small View”.

What we’re seeing is an empty, unsaved font document. 
It’s unclear to me what you’re meant to do here. Adding 
ascent and/or descent seems to do something, but 
clicking in the edit area only seems to increase the 
little number that is displayed. If there is a way to 
proceed from this starting point, I haven’t figured it out. 
Presumably, Apple developers had documentation that 
explained it all, but I’ve never found or seen it.

What you can do (and what I did back in 1984) is 
open one of the installed fonts using the “Load From 
Resource…” command, or open a font document using 
the “Read Font...” command (more on this later).

“Load From Resource…”  will open a font from the 
System file of the startup disk. There’s no “open” dialog 
box, so you’ll need to know the exact name and size of 
the font you want to open ahead of time. Therefore, it’s 
a good idea to make a note of what’s installed using the 
Font/DA Mover before starting Font Editor.

Don’t click anything yet.

An empty font document.

Loading a font from the System file.



A good starter is New York 24, assuming it’s installed. 
Be sure to type the name correctly, including spaces 
and capitalization. You will also need to type the size 
(24) in both size fields. If you type a larger or smaller 
size in the “NewSize” field, it indicates that you want to 
scale the font up or down (yes, this is possible—more on 
this later). Any mistakes here will cause a system error.

Click “OK” and the font will load. 

The Active Area

•	 The active editing area is indicated by the dotted 
rectangle in the middle of the large window. If you 
click inside this area, pixels will turn on and off. It’s 
very similar to the Fat Bits mode in MacPaint.

•	 The dotted line along the bottom of the letters is the 
font baseline.

•	 The number below the active editing area is the 
character’s ASCII number. 

•	 If you click on any of the other visible characters, 
either in the large window or the small window, that 
character will become the active character. In this way, 
you can navigate through the entire font. (I guess it 
was too much trouble to implement scroll bars.)

•	  The close box (upper left corner) doesn’t do anything.

The Edit Menu

•	 Insert Char. You probably don’t need this if you’re 
editing an existing font like New York, which already 
has a complete character set. This is presumably for 
when you’re starting from scratch, but see the next 
item for an example of when you might need it.

•	 Delete Char. This can be handy if you want to start 
over with a character. It deletes the active character. 
If you then do Insert Char (using the same ASCII code 
as the character you deleted), you need to provide an 
existing character’s ASCII number from which to copy, 
to be used as the basis for the new character. Be 
careful: If you leave the “character to copy” field blank 
you will get a system error and have to reboot.

•	 Char Left. This shifts the character to the left by one 
pixel. Note: Any black pixels that cross the active 
rectangle boundary will be cut off.

•	 Char Right. This shifts the character to the right by 
one pixel. Note: Any black pixels that cross the active 
rectangle boundary will be cut off.

Specifying the font to load.

Font Editor’s main windows.

The Edit menu.



•	 Char Up. This shifts the character up by one pixel. 
Note: Any black pixels that cross the active rectangle 
boundary will be cut off.

•	 Char Down. This shifts the character down by one 
pixel. Note: Any black pixels that cross the active 
rectangle boundary will be cut off.

•	 Insert Column. This adds a column of pixels along the 
left edge of the character box, shifting the rest of the 
character to the right and makes the character one 
pixel wider.

•	 Delete Column. This deletes a column of pixels 
from the left edge of the character box, shifting the 
character to the left and makes the character one 
pixel narrower. Note. Any black pixels in the deleted 
column will be lost. 

The Height Menu

•	  More Ascent. Adds a row of blank pixels to the top of 
the entire font.

•	  Less Ascent. Removes a row of pixels from the top of 
the entire font.

•	  More Descent. Adds a row of blank pixels to the 
bottom of the entire font.

•	  Less Descent. Removes a row of pixels from the 
bottom of the entire font.

The Aids Menu 

•	  Show Sample Window. Shows a sample of the font 
in its nominal point size in a smaller window. You can 
leave this window open while working in the other 
two windows, but it can’t be resized. You may need to 
click the “ReDraw” button if it doesn’t update to reflect 
the changes you’ve made. You can close this window 
with its close box (upper left corner) or by choosing 
Hide Sample Window from the Aids menu. 

•	  Set Sample Text. This allows you to change the text 
in the Sample Window.

The File Menu

•	 Read Font… This allows you to open a font document 
that was previously saved using the Save Font In… 
command. Note: If there are unsaved changes in the 
currently open font, they will be lost with no warning. 
See also Save Font In… below for more info about 
this file format.  If you specify a different size in the  

The Height menu.

The Sample Text Window.

The Set Sample Text window.



“NewSize” field, Font Editor will scale the font to that 
font size. This is a good way to start making a new 
size of a font. Note: Always use the actual size of the 
existing font in the “Current Size” field. Invalid values 
may lead to unpredictable results.  

•	 Save Font. Writes the current font to disk, saving 
any changes you’ve made. This applies both to font 
documents opened using the Read Font… command 
and to fonts loaded from the System file using Load 
From Resource… .

•	 Save Font In… Writes the current font into a font 
document file on the disk with the name you provide. 
I would recommend using a name that specifies the 
font name and size, such as MyFont 12. If the file 
already exists, it will be overwritten with no warning. If 
you want the file to be in a folder, you will have to 
move it there in the Finder. These documents can 
only contain a single font in a single size and have a 
generic icon. They are only readable or writable using 
Font Editor, and cannot be read by Font/DA Mover.  

•	 Load From Resource… Loads a font from the System 
file. The exact font name and size must be used. If not, 
you will get a system error and have to reboot.  As 
with Read Font…, if you specify a different size in the 
“NewSize” field, Font Editor will scale the font to that 
font size. This is a good way to start making a new 
size of a font. Note: Always use the actual size of the 
existing font in the “Current Size” field. Invalid values 
may lead to unpredictable results.

•	 Install Font… adds the font to the Fonts suitcase 
on the disk, but be careful. It can overwrite existing 
fonts in the Fonts suitcase since it does not check for 
FONT ID conflicts. Font Editor assigns font number 
12 to all new fonts. Do not use this command if you 
have used Install Font… with a different font you’ve 
made in Font Editor and have not yet chosen and 
assigned a font number other than 12 to it. Doing so 
will overwrite some or all of your earlier work. See 
FONT ID section below for more info about FONT IDs 
and font numbers.

•	 Undo All Changes. This does not seem to work. At 
best the app will hang, doing nothing but beeping 
when you click the mouse. At worst, it will cause a 
system error. In both cases, you have to reboot. Do 
not use this command.

•	 Quit. Quits the Font Editor app. If there are unsaved 
changes, they will be lost with no warning.

A font document has a 
generic icon and contains 
only one font in one size.

A font suitcase 
can contain 
multiple fonts for 
installation and 
distribution.

The File menu.



FONT IDs and Font Numbers
Font Editor, by default, assigns font number 12 to 
any fonts created in the app, including new fonts or 
fonts derived from existing fonts. Font number 12 also 
happens to be the number for Apple’s Los Angeles font. 
So, if you install your new font into the Font suitcase file 
and it containins Los Angeles, it will it will be a problem. 

For example, you have a font suitcase containing Los 
Angeles 12 and 24. You make a new font, MyFont 24. 
Using Font/DA Mover to put MyFont 24 into that font 
suitcase will wipe out Los Angeles 24, and Los Angeles 
12 will get its name changed to MyFont, even though it 
looks the same as before.

The same is true with fonts you have made previously, 
since they were also assigned font number 12. The 
key to avoiding this issue is to change the font number 
of your font from 12 to something else as soon as you 
install it into the Fonts file. In order to this, you will need 
to use ResEdit.

First, you need to pick a font number. The allowable 
range in the original font manager was 0-255. Numbers 
1-127 were reserved by Apple, who actually only used a 
few. (See the list at left.) Don’t use these. 

Fonts are stored in FONT resources. If you open the 
System file in ResEdit, you will see that the FONT IDs 
do not match the font numbers at left. This is because 
the FONT ID is a combination of the font number and 
the font size. This is calculated by multiplying the font 
number by 128 and adding the size. 

Each size of a font has its own FONT resource and 
FONT ID. The font name also has a resource with a 
FONT ID equivalent to what it would be at size 0.

For example, London, size 18 has a FONT ID of 786. 786 
− 18 = 768. 768 ÷ 128 = 6, the font number of London, as 
listed above left.

In short, FONT ID = (font number × 128) + size.

Let’s say you have a font called “MyFont” and want to 
assign the font number of 44 to your font, and that you 
have 12 and 24 pt sizes. The FONT IDs are calculated as 
follows:

FONT ID for the name “MyFont” = (44 x 128) + 0 = 5632 
FONT ID for size 12 = (44 × 128) + 12 = 5644  
FONT ID for size 24 = (44 × 128) + 24 = 5656

That’s all there is to it.

Font numbers to avoid.

FONT IDs are not the same as FONT numbers, but they are 
derived from them.



Fixing the Font Number and 
FONT ID with ResEdit
When you’re working on your font, you usually want 
to save it using the Save Font In… command, which 
is similar to the Save As... command on modern 
computers. This creates a font document (not a font 
suitcase) that you can open with the Read Font… 
command. 

While a font document is open in Font Editor, the Save 
Font command will save changes to this file. However, 
to use the font on your Mac and move it around with 
Font/DA Mover, you have to install it into a font suitcase, 
namely, the Fonts suitcase file on your disk, which is the 
only place that Font Editor can install it.

You do this opening the font and then using Install 
Font… to install it into the Fonts suitcase file. By default, 
Font Editor assigns font number 12 to your font, so don’t 
do this if your Fonts file already contains an earlier font 
for which you have not assigned a new font number 
or you may overwrite it. In this case, you need to fix 
the font number in that font first (using the following 
instructions, of course). 

When you’ve finished adding your font to the Fonts file, 
quit Font Editor and open ResEdit. In ResEdit, you will 
see a list of all the files on your disk. Double-click on 
“Fonts”. 

You should see a single resource item called “FONT”. 
This contains all the font resources in the Fonts suitcase 
file.

Instead of opening this by double-clicking, hold down 
the Option key first, then double-click. This gives you 
a more detailed resource list than you get without the 
Option key, and that’s what you need for this operation.

Option-double-click “FONT”.

Open the “Fonts” file.

ResEdit to 
the rescue.



You will now see two or more entries which pertain to 
your font. In the screenshot example they are FONT ID = 
1548 and FONT “MyFont” ID = 1536. The first one is the 
FONT ID for the bitmap data for font number 12, size 12 
(1548), the second entry is the FONT ID for the name 
resource (1536) which links the name “MyFont” to FONT 
ID 1548. These are the values we need to change.

Let’s start with FONT ID 1536, the resource for the font 
name. Select it and choose Get Info (command-I) from 
the File menu.

Let’s say you want to change the font number to 44. 
That means the FONT ID for the name resource will be 
44 × 128 + 0, or 5632. Enter this in the ID field and close 
the window. (Note: You can also change the name of the 
font here if you want.)

Next, select FONT ID = 1548 and do Get Info. The 
bitmap data resource FONT ID for this will be (44 × 128) 
+ 12, or 5644. Enter this in the ID field and leave the 
Name field blank. 

If you have more than one size for your font, you’ll need 
to do this with each size of the font using the same 
formula.

Close all the windows and click “Yes” when asked to 
Save “Fonts” before closing.

That’s it—you’re done. You can quit ResEdit and install 
and use your font anywhere you like. (As long as it’s a 
classic Mac.)

The detailed resource list.

The name resource FONT ID for FONT number 12.

The bitmap data FONT ID for size 12 (1536 + 12 = 1548).

Click the “Yes” button and you’re all done.



Closing Thoughts
Font Editor is not the tool you would use today if you 
want to make screen fonts for vintage Macs. I would 
recommend getting Fontastic Plus for that. It’s better in 
practically every way and works on more machines and 
versions of the Mac operating system—even as late as 
MacOS 8—and supports many more font IDs and font 
families through the use of the FOND resource. And you 
don’t have to deal with that font number 12 business.

My purpose in creating this how-to guide is to preserve 
a small but significant piece of Macintosh history. The 
Mac was the first affordable computer that went beyond 
the 40 or 80 column by 25 line text display, typical of 
personal computers in the early years. The Mac could 
display multiple proportional or fixed-width fonts in 
different sizes and styles anywhere on its screen. This 
was a radical new thing at the time.

Almost certainly, those early fonts were made using 
Font Editor, by people like Susan Kare and Bill Atkinson. 
With this guide, anyone can try it themselves and see 
what it was like.

There are still some unanswered questions. 

Who wrote it? I poked around in the app using ResEdit 
and Fedit, and looked at stories of the original Mac 
development team at folklore.org, but have been 
unable to determine who wrote Font Editor. My guess is 
Bill Atkinson or Andy Hertzfeld, but it’s only speculation.

How do you make a font from scratch? A glaring 
ommission in my how-to guide is how to create a font 
from scratch. When you launch the app, that seems to 
be the expectation. It asks you for a name and size and 
presents a blank canvas on which to work. I’ve been 
able to work out how to edit and modify existing fonts, 
but making a new font from a blank document has 
stumped me so far. I assume there was documenation 
for Font Editor at one time for those using it within 
Apple and at third-party developers. I’m hoping that 
by publishing this guide perhaps someone will come 
forward offering the missing documentation and/or 
explanations of how it’s meant to work.

That said, I hope people find this guide illuminating 
or even useful. If you have questions, corrections, or 
suggestions, feel free to contact me. 

Mark Simonson, 5/22/24 
marksimonson@mac.com


